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Section 1: Introduction

ARwall creates augmented reality technology that captures live, in-camera VFX
composites. Geared toward film productions, ARwall provides a viable alternative
to the green screen process and continually works to advance virtual production
technologies for all creators.

This product guide details the ARwall ARFX Pro Plugin product and describes how
to use it.

For more information on ARwall, visit: http://arwall.co
To contact ARwall, send an email to: support@arwall.co

Section 2: General Computer Set Up

This section describes how to set up your computer for use with the ARwall ARFX
Pro Plugin.

Section 2.1 Computer and Hardware Requirements

Before you get started, ensure that you have the hardware components listed in
Table 1 below for the most optimal performance for the ARwall ARFX Pro Plugin.

Table 1: Main Components and Accessories

Main Component Accessories

Windows PC machine with e 1xKeyboard

recommended Nvidia GeForce RTX e 1xMouse

2080 graphics card or better (minimum | e Optional: 1 x USB Hub

GTX 1080) e Optional: 1 x Xbox Controller and
USB Dongle

Vive Pro Tracking Hardware (see e Minimum: 2 x 2.0 Base Stations

section 3, Motion Tracking Hardware for | ¢ 2 x AC power supplies for Base

further information) Stations

e 1-2x2.0o0r 3.0 Vive Tracker(s)

e 2xUSB cable for each tracker

e 2 xUSB Wireless Dongle for each
tracker (label each dongle to
coincide with corresponding
tracker)

Optional Peripherals e 2 x % inch ball mount adapter and
stand (1 per Base Station or use an
equivalent % inch clamp or



http://arwall.co/
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peripheral for mounting base
stations)
e 2 x USB extension cable (1 for each
tracker)
License e Activation Code (provided by
ARwall)
e Steam (click link to create free
account)
e Epic Games (click link to create free
account)
Section 2.2 Boot Up Computer
If you are using your own computer
To boot up the computer, do the following:
1. Plugin all accessories, including:
a. Mouse
b. Keyboard
c. Monitor/Screen/Projector/LED wall
d. USB Hub

e. Any additional cables
2. Turn on the computer

Section 2.3 Password Protection

ARwall should have provided you with an Activation Code to access the ARFX Pro
Plugin. We will discuss where to enter this activation code in section Section 4.1:
Installing the ARwall ARFX Pro Plugin. This product is for a SINGLE seat license on a
single machine. If you would like to purchase additional seats, move to another
machine, or misplace your activation code, please contact your ARwall
representative or email support@arwall.co and we will provide it to you.

NOTE: According to the Terms of Sale, it is the responsibility of the purchaser to
secure all ARwall IP to the best of their ability. This includes, but is not limited to,
keeping your passwords secure, system password protection, and physical security
locks when appropriate.

Section 2.4 Prerequisite Software Installation

If ARwall did not build and issue a computer, be sure to install the following to
make sure your ARFX Pro Plugin runs seamlessly:


https://store.steampowered.com/join/
https://www.epicgames.com/id/register
mailto:support@arwall.co

e Unreal Engine 4.27 and/or Unreal Engine 5
e Steam

e SteamVR

e USB Deview

e .NET6 Runtime

e 7-zip

1. Install Epic Unreal Engine 4.27 and/or Unreal Engine 5:

a. Instructions here: https://docs.unrealengine.com/en-
US/GettingStarted /Installation/index.html

b. Be sure to create your own free account and have that login password
available.

c. When selecting the version to install, be sure to select 4.27 and/or 5.

2. Install SteamVR:

a. Install Steam:

i. Instructions here:
https://support.steampowered.com/kb article.php?ref=3046-
ECVN-3712

ii. Be sure to create your own free account and have that login
password available for your team.

b. Install SteamVR:

i. Within Steam, search for SteamVR and install (or use this
external link:
https://store.steampowered.com/app/250820/SteamVR/)

ii. This will assist you by showing you which Vive Pro devices are
connected or not. Great for trouble shooting!
3. Install USB Deview:

a. After installing SteamVR, USB Deview should be found at the following
location: C:\Program Files
(x86)\SteamVR\tools\USBDeview\win32\USBDeview.exe

b. If not found, follow the steps below to install USB Deview separately:

i. Download file from here:
http://www.nirsoft.net/utils /usbdeview-x64.zip

ii. Unzip the file in your desired location & install the software.
iii. This will assist you in finding your HTC Vive Serial numbers.
4. Install 7-zip:

a. Ifyour machine does not have 7-Zip, please download and install it

from here: https://www.7-zip.org/
5. Install .NET6 Runtime:

a. Download .NET6 Runtime here: https://dotnet.microsoft.com/en-

us/download/dotnet/6.0/runtime
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Download .NET 6.0 Runtime

The runtime includes everything you need to run existing .NET and ASPNET Core applications

Windows

Linux macOS

— —x
A _— =]

]
—

N

-_ o —

Run console apps Run desktop apps Run server apps

Do you want to run console apps that use .NET on your Windows Do you want to run a desktop app that uses .NET on your Do you want to run weby/server applications? The ASP.NET Core
computer? Install the NET Runtime. Windows computer? Install the .NET Desktop Runtime. Hosting Bundie includes the NET Runtime and ASP.NET Core

Runtime. If installed on a machine with IS, it'l also add the
ASPINET Core I1S Module.

Download x64 || Download x86 Download x64 || Download x86
Download Armé4 Download Arm64

Download Hosting Bundle

b. Choose Run Desktop apps > Download x64 and install
i. This installation is necessary for our login system to work
correctly.

BEST PRACTICE: It is recommended to pin SteamVR and USB Deview to the

Windows Start Menu for ease of opening the software when needed later. To do so,
right click on the EXE file and select “Pin to Start.”

'r' USEDeview.exe

Open

E;‘ Run as administrator

©) Share with Skype
Troubleshoot compatibility

Pin to Start
& Move to Onelrive b
7-7in b

Alternatively, SteamVR can be added by clicking Windows button, searching for
“SteamVR” using Microsoft Search and selecting “Pin to Start”



". | Apps Documents

& Best match

@ SteamVR
App
G SteamVR
& SteamVRexe App
Search work and web
/O steamvr - See work and web results Open
Folders (2+) Run as administrator
Open file location
Pin to Start
Pin to taskbar

Uninstall

® » O =H " @ ’ “ =TI : ®» W =

Section 2.5 SteamVR Software Set Up

After starting up SteamVR, if it asks you to plugin in your VR headset or HMD and
does not let you see the attached Vive Trackers or Base Stations without a headset
attached, do the following:

1.

Navigate to the drive that SteamVR is installed in on Windows and locate the
default.vrsettings file. It is usually located on the C Drive at C:\Program Files
(x86)\SteamVR\resources\settings\default.vrsettings

Open the default.vrsettings file with Notepad or equivalent software.

Locate the line “requireHMD”: true,
“YY/": “these detaults
¥

"steamvr":

"requireHmd”: true,

orcedlriver . s

"forcedHmd": "",

T e I T e

Change the word “true” to “false” and make sure the comma after the word is
still present.



"regquireHmd": false,
orcedUriver . ’
"forcedHmd™: "",

5. Save the file and close.
NOTE: If SteamVR updates, these steps may need to be repeated as SteamVR may ask
for the VR headset/HMD again.

Section 3: HTC Vive Motion Tracking Hardware Set Up

This section describes how to connect your Base Station and Vive Tracker

equipment.

Section 3.1 HTC Vive Motion Tracking Hardware

In Table 2 below, you will find a list of the Motion Tracking Hardware components.

Table 2: Motion Tracking Hardware Components

Vive Tracker

calibrate and track motion
within the range of the
motion-sensing Base
Stations

Name Information Quantity Image
2.0 Base Rectangular boxes with 2
Station motion-sensing capabilities | (minimum),
4 or more
for larger
spaces
AC Power Base Station power supply | 1 per base
Cable station
2.00r 3.0 Puck-shaped device used to | 2




Vive Tracker
Dongle

Provides a wireless
connection for Vive
Trackers, but it is
recommended to connect
trackers with cables and
dongle for best tracking
results. (Each Vive Tracker
comes with a Vive Dongle,
please label the dongle and
trackers that belong to
each other for ease of use.)

Section 3.2 Connect Base Station

Two (2) Base Stations are the minimum requirement to work with ARFX, but up to
16 Base Stations can be used at a time. It is recommended to use around 4-6 Base
Stations around the intended play area where the physical camera will be tracked
for optimal tracking. To turn on a Base Station, connect an AC power supply to each
Base Station and plug into the correct power outlet. Initially the Base Station will

display a blinking blue light.

Figure 1: Base Station On

[t will then turn into a white or green light to indicate that the Base Station is active.

Figure 2: Base Station Active




NOTE: There is minimal power draw per Base Station which makes it easy to share
power with on set film lights as needed.

BEST PRACTICE: Turn off /unplug the Base Stations when not in use to prevent
overheating and preserve the operating lifetime of the device. Each Base Station has a
little running motor inside that will eventually wear down the device over time. Having
a few backup Base Stations are recommended when preparing for a film production
shoot in case an older Base Station stops working on set.

Section 3.3 Connect Multiple Base Stations
To connect more than two Base Stations, you will need to make sure each Base

Station has its own unique channel number and SteamVR is tracking the correct Base
Stations.

Base station active

This base station is currently tracking.

Channel 10

NOTE: Newly purchased Base Stations will have default channels that might be the
same as existing Base Stations’ channels, usually channel 1. Make sure to test and set
Base Stations’ channels before mounting them.

BEST PRACTICE: If only two Base Stations are being used in your system, there is no
need to change the Base Stations’ channels. The system should work fine without
changing the channels from 1. However, if issues arise or more Base Stations are
added, be sure to change each Base Station to be on its own unique channel.

To set each Base Station with its own unique channel, do the following:

Locate the SteamVR App on the Computer and open it.

Connect a Vive Tracker to your machine via USB cables.

Plug in one Base Station.

Place the Vive Tracker in view of the Base Station. Each Base Station has a
120-degree field of view. This step can sometimes take several seconds
before the SteamVR recognizes the Base Station but moving the tracker in
front of the Base Station can help the system recognize it faster.

5. Hover over the (newly turned on) Base Station icon tracked on SteamVR to
record which channel is taken.

W
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Plug in another Base Station and repeat step 4 and 5.

If any Base Station is set to the same channel as the other Base Station(s), use
a paperclip or thumbtack and press the Channel button at the back of the Base
Station to set a different channel. There is a total of 16 channels to pick from.

Make sure the new Base Station’s channel does not overlap with existing Base
Stations’ channels.

Repeat steps 4-7 until all Base Stations have their own channels and are
tracked by SteamVR.

BEST PRACTICE: It is recommended to label the back of a Base Station the channel
that is assigned to that Base Station for ease of use and troubleshooting on set.

NOTE: For convention or XR heavy settings, there could be neighbors that are also
using Base Stations that could interfere with ARFX’s tracking. It is best to talk to them
about their Base Station setup and adjust channels and Base Station field of views
accordingly.

Section 3.4 Base Station Placement

Optimal Base Station considerations:

1.

2.

Goal is to make sure the Trackers will always be seen by at least one Base
Station regardless of where it is in the intended tracking/play area.

Each Base Station should be placed at a height of around 2 meters/6.5 feet
tall (light stands with proper adapters are recommended, but Base Stations
can be attached directly to higher walls, ceilings, or set pieces if needed).

11



3. Each Base Station field of view should be tilted slightly down towards the
intended tracking/play area.

4. Each Base Station field of view should slightly overlap other Base Station field
of views and all Base Stations together should cover the tracking area that
you expect the Trackers to be active in. Keep in mind that each Base Station
has a 120-degree field of view, but with creative daisy-chaining, a few Base
Stations can create a sizeable play area for the tracked camera.

5. Be sure that at least one Base Station can see the screen that you are using
(mainly the center of the screen, where you will be calibrating with a
tracker).

6. Make sure that Base Stations and tracking/play areas are away from sun light
or other reflective surfaces such as mirrors or glass if possible. These factors
can affect tracking and should be minimized as much as possible on set.

7. Some on set lights can cause IR radiation to interfere with tracking stability
with Base Stations. It is recommended to turn one light on at a time while
testing tracking to test if lights are causing tracking issues. Most common
lights that cause issues are older.

HTC Vive offers best practices for Base Station/Base Station placement here:
https://www.vive.com/eu/support/vive/category howto/tips-for-setting-up-the-
base-stations.html

Sample ARFX with HTC Vive Tracking Hardware Setup (Base Stations are identified
as “Lighthouses” in the below image)

ARWALL

Lighthouse 1 AR fX. System

= m

20x10ft 1.5mm pitch ~4K LED videowall @
(minimum size rec'd)

Lighthouse 2

LED Processor

_

use) (e

. Camera Tracker Calibration
2 Lighthouses (120° FOV) Tracker
for a 35x35ft camera tracking area

12
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Section 3.5 Connect Vive Tracker
To connect the Vive Tracker, do the following:

1. Locate the SteamVR App on the Computer and open it.

2. Plugin a Vive Tracker to the machine with USB cables and place it within
view of at least one Base Station that is powered on. If the Vive Tracker is
plugged in, you should be able to see the tracker on the SteamVR app.

BEST PRACTICE: If SteamVR asks for an HMD to be connected, refer to Section 2.5
SteamVR Software Set Up on how to turn this off.

NOTE: Ensure that the Vive Tracker is inside the range and within the 120-degree field
of view of at least one Base Station.

3. To pair the Vive Tracker, press the middle button on the Vive Tracker.

4. The light on the Vive Tracker should turn green or amber once it is paired.

NOTE: A green or amber light should show once the middle button is pressed. Do not
hold the middle button.

13



Figure 3: Tracker Pairing

Check the SteamVR app after the pairing is complete. The tracker and any Base
Stations that can see the tracker(s) should appear. Hover over the tracker icon; if
“Tracker Active” displays, the pairing was successful.

Figure 1: Tracker Connected and Tracking

; currently tracking.

If the tracker pairing was not successful, restart the SteamVR app, check cable
connections, and redo step 3.

NOTE: If the Base Stations are not reading, contact support@arwall.co.

BEST PRACTICE: Always charge the tracker when you are finished using it. To display
the battery life, hover over the tracker icon in the SteamVR app. It is recommended to
keep the trackers plugged in to the machine to keep the trackers always charged.

BEST PRACTICE While trackers can be used wirelessly (if the specified tracker’s
dongle is plugged into the computer or USB dongle), it is also recommended to keep
the trackers plugged for optimal tracking, especially if there are potential interference
such as neighboring AR/VR experiences or lots of cell phones in the tracking/play area.

The blinking light will change colors to indicate different statuses, as described in
Table 3 below.

14



Table 3: Light Indicator

Color Description
Blinking Red Low Battery
Amber while plugged in Charging, but
paired/active
White while plugged in Fully Charged,
but not
paired/active
Green Paired/active

Section 3.6 Identify and Label Vive Tracker Serial Numbers via USBDeview

To obtain each Vive Tracker serial numbers, do the following:

1. Connect the USB-A to Micro USB (for Tracker 2.0) or USB-A to USB-C (for
Tracker 3.0) cable from the computer to the Vive Tracker.
2. Open the USBDeview on your desktop.

=

&

3. Inthe USBDeview, under the Serial Number column, look for something that
starts with LHR. It will be listed with a serial number. If it displays as green,
this means it is active and connected to the machine.

a. To differentiate between the two trackers, connect only one tracker at
a time and see what shows up in USBDeview.

QUSEDeview
File Edit View Options Help
X@looo g
Device Name Description | Device Type Connected [ Safe To Unpl... Disabled | USB Hub | Drive Letter Serial Number
@ LHR USB Composite Device Unknown Yes Yes No No LHR-DF83EEB3

BEST PRACTICE: It is recommended to label your trackers with their unique Serial
Number for ease of identification on set. It is also recommended to label which wireless
USB Dongle belongs to which tracker by identifying them as A, B, etc. for ease of future
identification and troubleshooting.

NOTE: A two-Vive Tracker system is generally recommended, with a Calibration Vive
Tracker and a Hero Vive Tracker, but if only one tracker is available, please be sure
to use the same Serial Number of your one Vive Tracker for both Calibration Tracker
and Hero Tracker fields.
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Section 4: Adding ARwall ARFX Pro Plugin to Unreal Engine 4/5

This section describes how to install the ARwall ARFX Pro Plugin and add new
maps to an existing Unreal Engine 4/5 Project.

Section 4.1: Installing the ARwall ARFX Pro Plugin

This section explains the process of installing the ARwall ARFX plugin to an existing
Unreal Engine 4/5 project.

1. Extract the ARwall Plugin file (ie. ARwall_427_NL_2022-10-26.7z,
ARwall_503_NL_2022-10-26.7z, etc.) using 7-Zip by right clicking the file
and selecting 7-Zip > Extract Files....

B ARwall_427_NL_2022-08-20.7z
&3 ARwall_502 it 0230090 7>

3 ARwallM Open

g ARwall_4 a Share with Skype

_H ARwall 4 @ Move to OneDrive >
_H ARwaliM T-Zip > Open archive
& ARwall 4. CRC SHA > Open archive >
ARwall_4 lf Edit with Motepad++ Extract files...
ARwall_4 Ea Scan with Microsoft Defender... Extract Here
_old | Share Extract to "ARwall_503_NL_2022-09-20\"
ARwall 4 Open with... Test archive
-";’; TortoseGit > Add to archive...
Compress and email...
Restore previous versions Compress to "ARwall_503_NL_2022-09-20.7" and email
Send to > Add to "ARwall_503_NL_2022-09-20.zip"
T Compress to "ARwall_303_NL_2022-09-20.zip" and email
Copy
Create shortcut
Delete
Rename
Properties

NOTE: If your machine does not have 7-Zip, please download it and install it from
here: https://www.7-zip.org/

2. Choose where you want to extract to, then Click "OK"

3. Once extracted, locate your extracted folder, open it, and locate ARwall
folder. This will be the ARFX Plugin folder.

4. Copy the ARwall Plugin folder into an existing Unreal Engine 4/5 project’s
Plugins folder.

16
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BEST PRACTICE Be sure to use the Unreal Engine 4.27 plugin with an Unreal Engine

4.27 project file and use the Unreal Engine 5 plugin with an Unreal Engine 5 project

file. Using the wrong plugin version will prevent you from starting up the project. It is

recommended to organize your plugins with an exterior folder clearly identifying the

version of the plugin to copy into Plugins folders. Be sure not to change the name of the
actual Plugin folder of “ARwall” or else it will not work properly within Unreal Engine.

NOTE: If your project does not have a Plugins folder yet, please make one.

This PC » ARwall HD (D) » ARFX Plugins * ARwall_303_ML_2022-09-20 » ARwall »

UE4_Project

@ Mew é{) [D ED @ Tl sort
€ >~ T < Unreal Engine » Astronaut Pack » UE4_Project »
NewLeginEmails Name
UE4_Project Cenfig
Content
> 32 Dropbox
DerivedDataCache

» % OneDrive - Personal

Intermediate

~ [ This PC Plugins
> @M Desktop Saved
> & Documents (M Astronauts_Pack

»

>

>

>

>

»

>

!r_ Downloads

) Music

PN Pictures

i Videos

e Local Disk (C)

== ApplicationsssD (D)

= HHD (E)

Titems  1itern selected

= wiew

w

Date modified

1/26/2022 2:39 PM

Search UE4_Project

Type
File Folder
File Folder
File Folder
File Folder
File Folder
File Folder

Unreal Engine Proj...

Size

17



Note: How it should look inside the Unreal Engine 4/5 Project Plugins folder after

copying the pl

ugin there.

_ Plugins = [m] *
@ Mew ~ Tl sort ~ = ce
« > v _ <« Astronaut Pack > UE4 Project > Plugins » v O 2 Search Plugins
NewLoginEmails Name Date modified Type Size
UE4_Project ~ ARwall 8/15/2022 9:28 PM File Folder
> %% Dropbox
» @ OneDrive - Personal
~ [ This PC
> @M Desktop
> & Documents
> i Downloads
> (@) Music
> N Pictures
> B4 Videos
> e Local Disk (C)
> == Applications55D (D)
> == HHD (E)
1item E O
Note: What it should look like inside the ARwall Plugins folder.
~ ARwall = O X
@ Mew ~ T seort ~ = view - aee
- > o~ T _ <« Astronaut Pack > UE4 Project > Plugins > ARwall > ~ O 2 Search ARwall
NewloginEmails Name Date modified Type Size
UE4_Project _ Binaries File Folder
Config File Folder
> 3% Dropbox
_ Content File Folder
> @ OneDrive - Personal _ Intermediate File Folder
~ [ ThisPC Resources File Folder
> @M Desktop _ Source File Folder
> & Documents D ARwall.uplugin UPLUGIM File 2KB
5 b Downloads D Changelog 8/14/2022 11:18 PM Text Document 7KB
> @) Music
> N Pictures
> n Videos

5 e Local Disk (C)
> == Applications55D (D)

> e HHD (E)

8 items

18



5. Open the Unreal Engine 4/5 project containing the ARwall plugin.

Note: Make sure that the Unreal Engine 4/5 project is set to open correctly as a 4.27 or
5 project file. Otherwise, there will be an error upon opening the project.

6. Once you launch the uproject file and it reaches 75%, you will be greeted
with two pop-up windows. One will prompt you to enter your Activation
Code provided by ARwall and the other will open a browser window
requesting you to login.

Note: If this is your first time using the ARwall Plugin this pop-up might be hidden
under the Unreal Engine interface or the login screen. Please use ALT-TAB (hold down
ALT button and tap TAB button to cycle through to the correct window) to select the
Activation Code and Login screens if they are hidden behind other windows.

U

Please enter the activation code:

00000000|-0000-0000-0000-000000000000

7. Once you have entered your Activation Code, click OK. Navigate to the
ARwall Login screen.

Note: ARwall Login screen

8. Please log in using your existing login email and password.
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a. Ifthisis your first-time logging in, click “Sign up now” to create a
new email/password account. Be sure to use this same account for
all future logins.

b. If your email is a Microsoft related account, please use the
“Microsoft Account” button to login.

c. You will have 90 seconds to enter your login information,
otherwise this will appear and ARFX will close. If this happens,
click OK and launch the uproject file again.

9. Once you have logged in successfully, an authentication window should
appear.

@ Authentication Complete

€ > C @ localh )4 = ¥ - % = 0O

* YouTube & Artivive . @) Spline- 3D Editer o PIRATE [ = - Curi TurboSquid || 3D M... ArtStation - Market... »

Authentication complete. You can return to the application. Feel free to close this browser tab

10. Once you have successfully logged in, navigate to the Plugins window
located at the top left section under the Edit tab.

Errelropiiliefhis % Projects /<o File |Edit® Window Tools  Build

Window  Help

*7y Undo Create Pin Link

£) Undo History
*F Undo History

Light

Ciner

Visuz Conf +14 Editor Preferen
N Project Settings
Geon

I ings ¥ Plugins

T - Open the Plugins Browser tab.
All Classes ] Open the Plugins Browser tab. Pawn re
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11. If the ARwall plugin is not enabled, click the Enabled option and the
ARwall plugin should now be activated. Before restarting Unreal we need
to check a few more Plugins for the ARwall Plugin to work properly.

u ~ Pl
» Installed » ARwall

4 @ Installed
ARwall Version 1.0

"= Camera : BEWA LL

"= Rama

4 @ Built-In ) %3 Enabled
“=2D !
"= Advertising
= Al

"I= Analytics

File  Edit

¥ plugins

Installed > A

ALL PLUGINS

ARwall
INSTALLED 3 [YOWALL)
# Edit &P

ARwall

BUILT-IN

12. Start by searching for nDisplay plugin and disable it, if enabled. Then
search for SteamVR plugin and disable it, if enabled. Now you may
proceed with restarting Unreal Engine.

iil;

+ Add ndisplay
All Plugins
& ALLPLUGINS

Live Link Over iDiSpIay ©& sion 1
K Lvew or [T setup

LED

sion 1.0
Inc

File  Edit

& pluging

=+ add X s

All Plugins
<& ALL PLUGINS

BUILT-IN
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BEST PRACTICE If starting up the Unreal Engine project shows any errors, navigate
to project’s “Config” folder and delete any subfolders within that folder. Then proceed
to launch the uproject file again.

v . This PC Storage (E:)

l screenshots Name

tent
l Deri
l Intermediate
B
. Pictures

Storage (E:} Unreal Projects

Name

# Uefaultkd,
. DefaultEngine
. DefaultGame

ocuments

Unreal Projects

dDataCache

Mo

Delete Rename

nize

MobileTesting_UE5

Da

bileTesting_UE5

Date modified

File folder
Unreal Engine Proj...
CFG File

" New item ~

i Easy access ~

New
folder

nvert selection

New Open Select
Config
ified

PM

Section 5: ARwall Setup and Settings within Unreal Engine 4/5

This section describes how to set up ARwall ARFX Pro Plugin, use the ARwall ARFX
Pro Plugin Ul menu system, adjust the ARwall camera settings, set calibration, and

use bookmarked cameras.

Section 5.1: ARwall ARFX Pro Plugin Setup

To set up ARwall ARFX Pro Plugin, do the following:

1. Open the Unreal Engine 4/5 project in UE 4.27 or UE 5. Be sure to match the
version of the plugin to the version of the UE project file.
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2. To check that the Unreal Engine project file opens in the right version or to
change the version of the Unreal Engine project, do the following:
a. Right-click on the .uproject file and select Switch Unreal Engine
version.

TVIETTTEQIATE -
Saved
O dome
Open
' 1
@ Launch game
@ Generate Visual Studic project files

Switch Unreal Engine version...
9

2 s 5

b. Select 4.27 or 5 and click OK to set the version.

4,27 e
K Cancel
5.0 ~
QK Cancel

3. Once the project opens, navigate to the ‘Place Actors’ tab. If this is not present
when you open the project, it can be found in Windows > Place Actors.

4. Select the ARwall subsection and drag and drop an ARwallCameraActor to the
scene for each required level .umap.

a. Add the ARwallCameraActor to the scene by dragging it from the
Place Actors tab window (which is located on the left-hand side of the
Unreal Engine GUI images below) into the viewport window.

b. It does not matter too much where you drop the ARwallCameraActor
in the viewport window, but this will be where the scene starts when
you launch the scene. Feel free to move/adjust it to your preferred
starting location in your scene.
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o JOE V@ D@ =)= I

NOTE: Make sure to delete any other existing cameras or “Player Start” objects in the
scene.

5. Navigate to the Details panel for the newly added ARwallCameraActor. If this
panel is not active, please enable it by going to the Windows menu and
selecting Details.

a. Select the ARwallCameraActor within the Outliner

b. Navigate to the Details panel and click the big green button ‘+Add
Component’ in UE4 or the ‘+Add’ in UE5 drop down.

c. Type in ARwall and select the ARwallTrackingComponentSteamVR.
The ARwallCameraActor object should appear in the World Outliner
window.
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i= World Outliner £= Outliner

-

Label
5 4'g4 Untitled (Editor) world

& wz ARwallCameraActor] ARwallCameraActor]

*+* Atmospheric Fog

€ View Options~

4 Details & world settings

: =l 2 e
4+ Add Component - o Blueprint/Add Script

Rwall

W< ARwallCameraActor

B4 ARwallC

o ARwall

4T UTISETLOMpOne oL T >
%, CameraCompol 1 ARwall Tracking Component Steam VR

&, Cinem

6. Under ARwallTrackingComponentSteamVR, assign serial numbers for the HTC
Vive Trackers.
a. Entry 0: will be the Hero Vive Tracker, which is the main tracker on
the camera.
b. Calibration Serial Number: will be for the Calibration Vive Tracker

NOTE: To find the Serial Numbers for each tracker, refer to Section 3.6 Identify
and Label Vive Tracker Serial Numbers via USBDeview.

3 Details ® world E Eah
bl ARwallCameraActor] W« ARwallCameraActor

4+ Add Component ~

. ARwallTrackingComponentSteamVR]|

Search Details
4 ARwall

Mumber

al Number

BEST PRACTICE: You can also access the ARFX Pro Plugin Ul, where everything is
conveniently located in the same window without having to search for them
throughout Unreal Engine. Refer to Section 5.2: ARwall ARFX Pro Plugin Ul for
more information.

7. Physically measure the width and height of your physical screen. Be sure to
start and end from the pixel edge to pixel edge, not including the bevel frame,
if any.
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a. Enter the screen width and height under Screen Width and Screen
Height sections. Be sure to input them in centimeters.

# Details

) Details ® Vviorld Settings
» W« ARwallCameraActor

L% ARwallCameraActor ‘i

@ Blueprint/Add Script

+ Add Component >

Search Companents
fz ARwallCameraActor](Instance)

BEST PRACTICE: It is recommended to write down the width and height of your
physical screen in centimeters on a text document and save it somewhere easy to
find on your machine. This will make it easy to input these numbers again for

future projects.

In the editor window, move the ARwallCameraActor to its desired location to

8.
correspond to the real world. This will be where the scene starts at launch.

NOTE: By default, the UE4/5 units are displayed in centimeters.

b CE= (DED €l JeE @ )@ =)=

35mm | Av: 2.8

* FilmbackPreset: 16:9 Digital Film | Zoom:
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BEST PRACTICE: For best experience when launching a scene, align the camera to the
floor after dropping in ARwallCameraActor. This is especially important if you're
trying to match the virtual scene as an extension of the physical set. Adjust the
ARwallCameraActor until you see the bottom of the screen match the bottom of the
virtual map (the bottom yellow line helps show if you’re on, below, or above the map

floor).

Changing snap size can help make micro-adjustments to align the bottom of the
ARwallCameraActor to the map floor.
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NOTE: Be sure to create your scene to match world scale 1:1, or else the sizing of
objects will look very off when the scene is launched with camera tracking.

9. To launch the scene, click the Play button or use the hotkey Alt-P.

a. Itisrecommended to play the scene in Selected Viewport to allow
manipulation of the scene, within the Unreal Engine editor, while in
play mode. Before clicking Play click on the drop-down icon next to
the Play button and select Selected Viewport. This will ensure that all
future play sessions will open in a viewport.

b. If using multiple viewports, make sure to select your intended
viewport before pressing Play or using hotkey Alt-P. The scene will
play in the last selected viewport.

BEST PRACTICE: It is recommended to full screen your viewport on your intended
backdrop screen by pressing F11 on your keyboard when that viewport is selected. If
needed, also hide the taskbar to use the entire screen with ARFX backdrop.

=

+ P Selected Viewport
F.. Mobile Preview ES3.1 (PIE)
P New Editor Window (PIE)

Section 5.2: ARwall ARFX Pro Plugin Ul

You can access the ARFX Pro Plugin User Interface (UI), where everything is
conveniently located in the same window without having to search for them
throughout Unreal Engine. Follow the steps below to open the Ul menu:

1. Click the ARwall menu option, next to the Windows menu option in the upper
left-hand corner of Unreal Engine and select ARFX.
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File Edit Window ARwall Tools Build

(41

A Untitled ARfx

Virtual Production
act Mod '

ol

2. This will open a new window where you can input all necessary information
to get Virtual Production and tracking working in one place. There are three
tabs to choose from:

a. Camera Options: This section provides the basic ARwall Camera
Actor and Tracking Component options in one easy to access Ul

g 1eprints/V

u' /ARwall/Blueprints/... %

JARy
ARwall Camera

4 Camera Options

lipping Distance

4 Camera Bookmarks

TransitionCurve F Transition Curve
* D
Transition Play Rate
Transition Play Rate .

Tracking Component

4 Steam VR Tracking Component

Tracking Fram

ocity TI

Calibration Tracking

i. ARwall Camera: an ARwall Camera Actor will need to be
added to the map for this section to show up in this menu.
1. Select Camera button can help you find your ARwall
Camera Actor if it has already been added, but not
already shown in this panel
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il

2. Camera Options
a. Disable Tracking: Disables tracking if checked
on
b. Screen Width: Enter screen width in centimeters
c. Screen Height: Enter screen height in
centimeters
d. Near Clipping Distance: “Clips away” the virtual
surface/object to unblock the virtual camera
view, increase value to remove more of the
object/plane, decrease value to remove less of
the object/plane
3. Camera Bookmarks: Make adjustments to bookmarks
and transitions between bookmarks
a. Disable Indexing
b. Do Not Create Origin Bookmark
c. F Transition Curve: Provides control of the
animation between bookmarks
d. Transition Play Rate: Adjusts speed of
animation between bookmarks
Tracking Component: Steam VR Tracking Component:
ARwall Tracking Component SteamVR will need to be added to
the ARwall Camera Actor for that section to show up in this
menu.
1. Hero Serial Number: Enter serial number for HTC Vive
tracker that will be placed on the physical camera
2. Calibration Serial Number: Enter serial number for
HTC Vive tracker that will be used for calibration
3. Samples: Number of samples taken out of 256 frames
per second to calculate the velocities used in thresholds
4. Tracking Frame Delay
Velocity Threshold: For UE4, start at 0.01 or 0.02 and
adjust as needed
a. increase value by 0.01 at a time to decrease jitter
on trackers
b. decrease value by 0.01 at a time to improve slow
camera tracking movements
6. Angular Velocity Threshold: For UE4, start at 0.01 or
0.02 and adjust as needed
a. increase value by 0.01 at a time to decrease jitter
on trackers
b. decrease value by 0.01 at a time to improve slow
camera tracking movements
7. Velocity Power Threshold: For UES5, start at 13 or 14
and adjust as needed
a. increase value by 1 at a time to decrease jitter on
trackers

U
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b. decrease value by 1 at a time to improve slow
camera tracking movements
8. Angular Velocity Power Threshold: For UE5, start at
13 or 14 and adjust as needed
a. increase value by 1 at a time to decrease jitter on
trackers
b. decrease value by 1 at a time to improve slow
camera tracking movements
b. Bookmarks: This section provides the basic ARwall Bookmarks
options in one easy to access Ul
i. Bookmarks: Select the bookmark to adjust from the dropdown
menu and adjust in options below.
1. Refresh
2. Select
3. Create: Adjust viewport to preferred virtual camera
position (not in play mode) and click Create button to
create a new bookmark in that position

Il/Blueprints/ W /ARwall/BlueprintsW

Camera Options Post Process Options
0L EICEI ARwallBookmark1 =

b Transform

I Current Camera Settings
- Camera Options

1 ARwall

4 ARwall Bookmarks

[» Transition

» Camera

» Post Process

» Lens

- Color Grading

» Rendering Features
» Tags

» Component Replication
 Activation

- Variable

» Cooking

i Tick

> Replication

I Physics

I» Asset User Data
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c. Post Process Options: This section provides the basic Post Process
Volume options in one easy to access Ul.
i. Post Process: Post Process Volume will need to be added to the
map for this section to show options. Make sure to set PPV to
Enabled and Infinite Extent (Unbound).
ii. Select the Post Process Volume to adjust from the dropdown
menu and adjust in options below.

Camera Options Post Process Options

4 Rendering Featu

NOTE: When re-opening an Unreal Engine project that already had the ARFX Pro
Plugin Ul window open, it may show as a blank/black window. Simply close out that
window and relaunch the ARFX Pro Plugin Ul window from the Unreal Engine menu
as described in steps 1-2 above to re-open the UL
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Section 5.3: Physical Camera and Hero Tracker Offset Setup

The Camera Offset function allows you to change the settings inside Unreal Engine
4/5 in order to match the physical distance between the physical camera sensor and
the hero camera tracker.

NOTE: This is not always necessary, but if there are perceived issues in parallax or
scale when in play mode, the camera offset should be adjusted. Accurate recordings
help the virtual and real environments to match. If there are no perceived issues, then
these settings can be left alone.

1. Set up physical camera hero tracker offset to match in Unreal Engine.
a. Match the virtual ARwall Camera Actor offset to match the physical
camera hero tracker offset.

i. Measure the vertical (up/down, X-axis), depth
(forward/backward, Z-axis), and side to side (left/right, Y-axis)
physical distance in centimeters from the physical camera
sensor to the bottom/center of the physical Vive hero tracker.

BEST PRACTICE: A physical camera’s sensor’s depth is often represented by focus
puller hook. Make sure to account for the sensors depth when measuring for the x-axis

offset.

ii. Follow the examples displayed in the image below to offset
correctly. Left offsets negatively, right offsets positively.
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USB cable port
(UR} points front

FORUARD
(Z&)
RIGHTE
(0]
DOWN OFFSET GUIDE FOR
(O3 CAMERA/HERO TRACKER

iii. Inputthe X, Y, and Z-axis values determined from physical
measurements into ARwallCameraActor > OffsetComponent >
Transform > Location’s X, Y, and Z-axes.

5 Details @ World Settings A& Details
ol ARwallC Actor] L
b =l n. ARwallCameraActor
#+ Add/Component ~ . Blueprint/Add Script
Search Components
% ARwallCameraActor](Instance)
eComponent ( e )
votComponent (PivotComponent) (Inherited)

4. OffsetComponent (PivotOffset) (Inherited

x IS V) 2 G

S ) ~ K

x S VNS 2 GES)
Stati tion: [ Mobility Static Stationary = Mavable

Mobility

Section 5.4: Change ARwall Camera Settings

Changing the ARwall camera settings allows you to match the virtual camera to the
physical camera as closely as possible by changing the camera, lenses, focus, and
aperture.

NOTE: While the following settings below can help match the virtual ARFX camera to
the physical camera, the placement of the physical camera will also change how the

virtual camera angle looks. It is a delicate dance between virtual camera and physical
camera to get the right look for a shot, and it is recommended to have tech rehearsals
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ahead of production shoot days to pre-set virtual camera settings and bookmarks and

physical camera locations on the physical set.
To change the ARwall camera settings, do the following:

1. Select the ARwallCameraActor in your scene or in the World Outliner,
navigate to the Current Camera Settings section in your Details panel.

2. Click on the box in this section to display a dropdown list of cameras or
lenses that you can select from to match your equipment

el ARwallCameraActorl /. Details x

4+ Add Component ~ 7 Blueprint/Add Script B« ARwallCameraActor
D

. mponent (Inherited)
FL Y etComponent (Inherited)

ameraComponent (Inherited)

icMesh (Inherited) :

) g Editin G+t
i (Inherited)

€ ARwallTrackingComponents

Current Horizontal FO'

4 Color Grading

I Highlights
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T Details

"
+ Add Component ~ o Blueprint/Add Script
4w FIVOLU (Inherited)

4 OffsetCo

‘&z CameraComponent (Inherited)

rited

4 Current Camera Settings

16:9 DSLR -

Universal Zoom

Current

Current He

4 Color Grading

. Highligh

T Di

¥ a

+ Add Gomponent - & Blueprint/Add Script
0

4 &, offsetComponent (Inheritec

‘4z CameraCompanent (Inherited)

4 Current Camera Settings

16:9 DSLR

/. Detai
W« ARwallCameraActor

W4 ARwalll

rent Camer

Custom
1z Prim
im Prime /1.4

Prime /1.8

106mm Prime f,

mm Prime f/2
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Section 5.5: Adding ARwall Bookmark Cameras

Adding an ARwall Bookmark Camera helps you bookmark a specific virtual camera
angle of the scene you would like to shoot. This allows quick movement from one
virtual camera angle to another, making shooting multiple angles in a scene easy
and quick.

To add ARwall Bookmark Cameras to a scene, do the following:

=

Open the Unreal Engine 4/5 project.

2. If using multiple maps within one project, under the Content Browser section,
load the level .umap you want to add the bookmark cameras to.

3. Add the bookmark camera to the scene by dragging it from the Place Actors
window under the ARwall tab shown in the next image, which is located on
the left-hand side of the Unreal Engine GUI.

4. Drag the ARwall Bookmark Camera to the desired location in editor window.

¥ Place Actors

Recently Placed

iwall Camera Actol
ARwall

ARWALL
Basic =4 ARwall Camera Rig
ARwall Camera Actor

Lights

e raclki 3 .

twall Tracking Rig aRwall Multi Screen Camera Acte

Cinematic

Virtual Production i ARwall Bookmark B¢ /Rwall Canon Camera Actor

Visual Effects
ARwall Camera R
) Scene Bookrr a4
Media
ARwall Tracking Rig
Geometry .

Volumes ARY skmark

All Classes

aRwall Scene Bookmark

NOTE: You can also create a bookmark with the “backspace” hotkey on the keyboard
while in Play mode. This will create a bookmark wherever the virtual camera is
currently placed.

BEST PRACTICE: Ifyou're trying to match the virtual scene bookmark as an
extension of the physical set, do the following:

While the ARwallBookmark camera is selected, navigate to Details > ARwall and check
the "Draw Screen" checkbox to show the screen size for all future created ARwall
Bookmarks.
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1. Details @ Wworld Settings

Nl ARwall8ookmarké
RO

<5 Blueprint/Add Script

3 ARwallBockmarks{instance)
S nponent (SceneComponent) (Inherited)
ponent (CameraCom ent) (Inherited)

4 ARwall
» Procedural Mesh

If left checked on as default, this can create a cluttered map to work in, so use with
caution. Adjust the Bookmark Screen until you see the bottom of the screen match the
bottom of the virtual map (the bottom yellow line helps show if you're on, below, or
above the map floor).

BEST PRACTICE: Snapping the virtual camera to a surface can perfect your virtual
camera location before creating a bookmark. While in play mode, you can snap your
camera to different surfaces by pressing "T" on the keyboard or pressing down "Left
stick” on your Xbox controller to toggle on/off Snap Mode. Once enabled, use the arrow
keys on the keyboard or the D-PAD arrows on the Xbox controller in the direction you
want to snap to. Be sure to disable Snap Mode once finished by pressing "T" or "Left
stick” again.

Section 5.6: Changing ARwall Bookmarks Order

To change bookmarked camera order, do the following:

1. Open the Unreal Engine 4/5 project

2. If using multiple maps, under the Content Browser section, load the level
.umap you want to adjust the bookmarked camera order for.

3. Once the map is loaded, go to the (World) Outliner and type ARwall into the
search bar as shown below.
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= World/Outliner

Showing 4 of 149 actors @ View Options~

f= Outliner

4. You will see a list of ARwallBookmarkCameras located in the scene.

Click on ARwallCameraActor.

6. Under the Details section, go to the second scroll bar and scroll down until
you see ARwall Bookmarks as shown below.

U

Search Components D
fuz ARwallCameractorT (Instance)

[earch Details Jo) =

=
(+)
o

o)

OO

®

®
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7. Click to check the Disable Indexing box. This stops ARwallCameraActor from
assigning bookmarked camera order based on which camera is loaded first.

8. Click on the ARwallBookmarkCamera that you want as the second
bookmarked camera in the chain.

9. Under the Details section, scroll down until you see ARwall/ARwall Toolset.

Click the triangle next to Bookmark to open the drop-down list as shown
below.

8 Details ® worle

-8 ARwallBookmarkl .

4+ Add/Component ~ o Blueprint/Add Script
Search Components
= ARwallBookmark1 (Instance)

# Details
&+« ARwallBookmark

&« ARwallBookmark (Instance)

Jnly [ ]

ARwall
4 ARwall Bookmarks

fide
o Ignore 0 Array elements

5 to Hide 0 Array elements

10. Go to Bookmark Index and change the index number to 1. This is the second

camera in the chain. ARwallCameraActor is the first in the chain and will have
an index number 0.
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B4 ARwallBookmark
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=+ Add/Component = & Blueprint/Add Script

i« ARwallBookmark (Instance)
Search Components
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ARwall Bo
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11. Repeat Steps 8 - 10 to set up the next bookmarked camera in the chain by
setting the third camera with Bookmark Index number 2 and so on.

NOTE: These changes will only apply to the current map and will not be applied to
other maps in the project.

12. Once the Bookmark Index numbers have been set, click save and you can run
the scene normally.

BEST PRACTICE: It is best to check the bookmarked camera in editor viewport before
changing the Bookmark Index number. This will make sure you have the bookmarked
camera that you want in the correct order.

NOTE: To revert the bookmark settings back to default, just change the Bookmark

Index number for each ARwallBookmarkCamera back to -1. Next, go to
ARwallCameraActor and make sure the Disable Indexing box is unchecked.
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Section 6: Calibration and Virtual Camera Control

This section describes how to calibrate ARwall ARFX using the patented XR Sync
system and describes how to use the ARwall camera controls once ARFX is up and
running.

Section 6.1: XR Sync Calibration

This section describes how to calibrate ARwall ARFX using the patented XR Sync
system. This process is the same whether running ARFX through the ARFX
Launcher or through Unreal Engine 4/5.

Once the ARwall ARFX scene is up and running, calibrate the scene so that the
proportions and parallax looks correct to the tracked physical camera. To perform
calibration in ARwall ARFX, do following:

1. Press the TAB key on a keyboard or X button on an Xbox controller, the
calibration screen will open. Locate the center of the screen marked by the
red crosshairs.

-
Place calibration tracker on crosshairs

Press C to calibrate .
Press to toggle calibration mode

2. The green triangle/square that appears represents the calibration tracker.
The current position is always relative to the last calibration point but should
always move in relationship to wherever you move the calibration puck.

NOTE: The green triangle/square should move when moving one of the trackers
connected to the system. This is the tracker previously set as the calibration tracker. If
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this is not the intended tracker for calibration, either swap the trackers physical
positions (on the camera vs next to the screen) or swap the serial numbers. Further
information on how to obtain the serial numbers can be found here: 5

3. Place the calibration puck flat against the screen and centered on the
crosshairs with the green light on the tracker facing up (for 2.0 Trackers) and
with the green light on the tracker facing down (for 3.0 Trackers). Both 2.0
and 3.0 Trackers will have the cable pointed up for correct calibration. Press
the Calibration button (that was set previously under Hotkeys, by default it
should be the C key on keyboard and B button on Xbox controller) while the
calibration puck is on the crosshairs, then press TAB (or whichever button
was previously set under Hotkeys) to exit the calibration screen.

2.0 Trackers

43



BEST PRACTICE: Feel free to press the Calibration button again if it does not look like
it calibrated correctly the first time. Make sure the calibration tracker is positioned in
place on the red crosshairs, until it looks like the ARFX Screen looks correctly
positioned and does not jump around a lot between calibration button presses. This
ensures that you have the most optimal calibration.

NOTE: It is good practice to recalibrate anytime a lighthouse is moved or bumped,
even if very minute. This could cause jitter/jumping of the virtual camera if not
recalibrated.

4. If calibrating for a multiscreen version of ARFX Pro Plugin, the crosshairs
will be green (instead of red) and the box representing the calibration puck
will be a red box with a plus sign in the middle. Otherwise, calibration should
be the same for multiscreen.
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Section 6.2: Calibration Puck Tracker Offset Setup

If for any reason the calibration puck cannot be physically placed on the center of
the screen during the calibration process, it's possible to add an offset for calibration
so that calibration puck can be placed somewhere more accessible. The Screen Offset
function allows you to change the settings inside Unreal Engine 4/5 to match the
physical distance where the center of the physical screen is and where the
calibration puck may need to be on set.

NOTE: During calibration mode, the bottom of the calibration tracker needs to be
pointed at the screen, placed flat vertically on the center of the screen where the red
crosshairs show. When using an offset location for the calibration puck, make sure to
keep the bottom of the tracker still pointing towards the physical screen. This may
require a % inch screw set up that keeps the puck in that same 90 degree rotation.

1. Setup calibration tracker offset to match in Unreal Engine.
a. Match the virtual ARwall Camera Actor offset to match the physical
camera hero tracker offset.

i. Measure the vertical (up/down, Z-axis), depth
(forward/backward, X-axis), and side to side (left/right, y-axis)
physical distance in centimeters from the center of the red
crosshairs from the screen while in calibration mode to the
bottom/center of the physical Vive calibration tracker.

BEST PRACTICE: It is recommended to place your offset calibration tracker in a
position that is precise, still, and unmoving.

ii. Follow the examples displayed in the image below to offset
correctly. Left offsets negatively, right offsets positively.

bottom of tracker
UP) points to screen
(Z))

USB port
points up

(Oxz)

OFFSET GUIDE
&) FOR CALIBRATION TRACKER
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iii. Inputthe X, Y, and Z-axis values determined from physical
measurements into Details > ARwallCameraActor > ARwall >
Screen Offset > Location’s X, Y, and Z-axes.

) Details @ world Settings

ol ARwallCameraActor]

4+ Add Component ~ & Blueprint/Add Script

# Details X

W< ARwallCameraActor

W4 ARwallCameraActor (Instance)
Search Components
lwg ARwallCameraActor] (Instance)

Q,

GUVETTE ARwallCamera

[ |
O
[Havaicomers
Tl |
I
o
I
[ |
Boem 5
ooom

Section 6.3: Virtual Camera Control

This section describes how to use the ARwall camera controls for both keyboard
and Xbox controller once the ARFX Pro Plugin is launched and calibrated.

1. Play ARFX Pro Plugin scene within Unreal Engine 4/5 and calibrate. Refer to
Section 5: ARwall Setup and Settings within Unreal Engine 4/5 and Section
6.1: XR Sync Calibration for further details.

2. Move the Hero Tracker (tracker on the physical camera) within the
designated play area as dictated by the base stations. The scene should show
the correct parallax.

BEST PRACTICE: Here is how to tell if you are seeing the correct parallax after
calibration:
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e Move the physical camera left, you should see more of the right side of the
virtual scene environment.
e Move the physical camera right, you should see more of the left side of the
virtual scene environment.
e Move the physical camera up, you should see more of the bottom of the virtual

scene environment.

e Move the physical camera down, you should see more of the top of the virtual

scene environment.

e Move the physical camera closer to the screen, you should see more of the
virtual scene environment.

e Move further from the screen, you should see less of the environment.

If this is not what you're seeing, try to calibrate again and make sure that the base
stations can clearly see each other and the trackers. Refer to Section 3.4 Base Station

Placement for further details.

The default virtual camera controls are described in Table 4 below.

Table 4: Virtual Camera Controls

e W =Forward
e S =Backwards

Action Keyboard Xbox Controller
To move the virtual Use the WASD navigation | Left Stick is the
camera controls: Forward, Backwards,

Left, and Right control.

(Refer to Section 6.3: Input
Scale if using these hotkeys
does not rotate/pan)

e Use the left arrow
(<) to pan the camera
left.

e Use the right arrow
(=) to pan the camera
right.

o A=Left

e D =Right
To move the virtual Use the following Left Trigger is to move
camera up or down controls: vertically down

e Q=Down Right Trigger is to

e E=Up move vertically up
To rotate/pan the virtual Use the following Right Stick pans the
camera left or right controls: camera

LB (Left shoulder
button) rotates 90
degrees left

RB (Right shoulder
button) rotates 90
degrees right

To toggle the calibration
menu

Use the Tab key:
e Press Tab to toggle
on/off

X button to toggle
on/off
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To calibrate the screen
(while holding up the
calibration puck to the

Use the C key:
e Press Cwhile
calibration puck is

B button while
calibration puck is held
in the center of the

center of the screen held in the center of screen

crosshairs, so the parallax the screen

and camera tracking look

correct)

To toggle focus method Use the F key: A button or press down

e PressF to toggle
on/off the focus
method

the Right Stick button
to toggle on/off the
focus method

To toggle focal distance
input (also adds focal
plane)

Use the P key:

e Press P to toggle
on/off the Draw Focus
Plane, should look like
a transparent purple
wall on screen
indicating your focus
plane

e Use the up arrow (T)
and the down arrow
(1) to change the focal
distance

Y button or while in
normal mode: hold D-
PAD Down arrow to
toggle between focus
enabled mode and
normal mode.

While in focus enabled
mode:

e Press D-PAD
Right arrow to
increase Focal
Distance (+)

e Press D-PAD
Left arrow to
decrease Focal
Distance (-)

To toggle camera debug
info

Use the Z key:

e PressZtotoggle on
the camera debugging,
positional data,
rotation data, and FPS

e Press the Z key again
to remove positional
and rotational data,
but keeping FPS

e Press the Z key again
to toggle off camera
debugging

Press the View button
(looks like 2 rectangles)
to toggle on/off camera
debug info
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To add a bookmark

Use the backspace key:

e Press backspace
to create a new
bookmark where
the virtual camera
currently is placed

While in normal mode:

e Press D-PAD
Left arrow to
create a new
bookmark where
the virtual
camera currently
is placed

To change bookmark or
preset camera angle

Use the minus (-) or

equal (=) keys:

e Pressthe + key to fly
to the next bookmark

e Press the - key to fly
to the previous
bookmark

While in normal mode:
e Press D-PAD
Right arrow to
fly to the next
bookmark

To toggle snap mode of the
virtual camera

(This forces the virtual
camera to snap towards a
direction on the virtual
environment.)

Use the T key:

e PressT to toggle
between snap mode
and normal mode.

While in snap mode:

e Press the Up arrow
(T) once to snap
vertically up

¢ Hold the Up arrow
(T) to snap forward

¢ Press the Right
arrow (=) to snap
horizontally right

e Pressthe Down
arrow (1) to snap
vertically down

e Hold the Down
arrow (1) to snap
backward

e Press the Left arrow
(<) to snap
horizontally left

Press down Left Stick
button to toggle
between snap mode and
normal mode.

While in snap mode:

e Tap the D-PAD Up
arrow (T) once to
snap vertically up

¢ Hold the D-PAD Up
arrow (T) to snap
forward

¢ Pressthe D-PAD
Right arrow (-) to
snap horizontally
right

e Tap the D-PAD
Down arrow ({) to
snap vertically down

e Hold the D-PAD
Down arrow ({) to
snap backward

e Pressthe D-PAD
Left arrow (<) to
snap horizontally
left
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To toggle rotation method

Press the V key to toggle

between:

e Rotating at camera
locked to the Y axis
(left and right only)

e Rotating at screen
(free pitch up and
down)

To Rotate:

e Use the left arrow
(<) to rotate the
camera left.

e Use the right arrow
(=) to rotate the
camera right.

While in normal mode:
press the D-PAD Up
arrow to toggle

between:

e Rotating at camera
locked to the Y axis
(left and right only)

e Rotating at screen
(free pitch up and
down)

To Rotate:

e Use Right Stick to
rotate the camera

To reset pitch & roll (move
method) of the virtual
camera

Press the R key to:

e Reset the side-to-side
or Y axis and the front-
to-back of the X axis

While in normal mode:
hold the D-PAD Up
arrow to:

e Reset the side-to-side
or Y axis and the
front-to-back of the X
axis

To toggle move method

N/A

While in normal mode:
Tap the D-PAD Down
arrow to toggle on/off
moving only in the XY
plane (cannot go
up/down)

To bring up the menu
system

(Refer to Section 6: Menu
System for further details)

Press the ESC key or

Backslash (\) to:

e Open the menu
system, where you
can control ARFX
settings, Post Process,
Hotkeys/controls,
audio, etc.

Press the Menu button
(looks like a hamburger
menu) to

Open the menu system,
where you can control
ARFX settings, Post
Process,
Hotkeys/controls,
audio, etc.
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To enter Fullscreen in Play | Select the ARFX Screen N/A
mode (if the ARFX screen | and press the F11 key:
popups as a window, use e This will toggle on/off
this to set it to full screen) fullscreen mode

~ Backspace
Cmd

Console}

Tab
ARfx Calibr.
Screen D

Create Sookmark

Delete | | End

Caps Lock A s D F s ||H J K L : P Enter
Strafe trafe Tl Mo
Left Back Right Method o
Shitt z Yol | va || & N M < B 2 Shift
‘Camera

Modifier lodifier

Menu

Move Vertically Down: Move Vertically Up

Rotate 90° Leﬂ—\' Rotate 90° Right
.\
o ; ' -

Stick: Move Camera

Press: Toggle Snap Mode Toggle Calibrate Menu

-Toggle Focal Distance Input
Normal (Tap): Toggle Rotation Method .
Normal (Hold): Reset Pitch/Roll 2) Calibrate Screen

Snap Mode (Tap): Snap Vertically Up

—— Toggle F Method
Snap Mode (Hold): Snap Forward—__""‘—-—-._._______ 0ggle Focus Hietho

Normal: Create Bookmark
Focus Enabled: Focal Distance (-)

Snap Mode: Snap Horizontally Left
Normal (Tap): Toggle Move Method
Normal (Hold): Toggle Focal Distance Input Stick: Rotate Camera

Snap Mode (Tap): Snap Vertically Down Norrhal: Next Bookmark Press: Toggle Focus Method
Snap Mode (Hold): Snap Back Focus Enabled: Focal Distance (+)
Snap Mode: Snap Horizontally Right

Refer to end of manual for larger version of keyboard and Xbox Controller hotkeys
or refer to the keyboard hotkeys online here: http://www.keyboard-layout-
editor.com/#/gists/98cd82217ffeleb61fc7a6ae19d97862

Section 6.4: Input Scale

This section describes how to adjust the movement speed of the ARwall camera
controls for both keyboard and Xbox controller once the ARFX Pro Plugin is
launched and calibrated.
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1. Ifthe arrow keys described in Table 4, which are used to rotate/pan the
camera left or right, are not working, verify whether the four Input Scale
options (Input Yaw Scale, Input Pitch Scale, Input Roll Scale, and Input Scale)
inside the ARwall Camera match or have a value higher than 0 as displayed in

Figure 5 below.

Figure 2: ARwall Inputs
8 Details & worl ings # Details X
* n

W< ARwallCameraActor

“ameraActor (Instance)

+ Add Component:- &2 Blueprint/Add Script

Edit in C+

Search Components

2. If moving the virtual camera is too slow or too fast while using WASD or the
XBOX Controller left stick, adjusting Input Scale higher or lower will adjust
this speed.

a. Forinstance, if a map is very large in scale, a higher Input Scale
value (around 10-50) will help traverse the map more quickly.
Conversely, if the Input Scale value is too high on a smaller
map, lowering the value to 5-10 might be preferable.

Section 6.5: Near Clipping Distance

This section describes how to adjust Near Clipping Distance of the ARwall camera
once the ARFX Pro Plugin is launched and calibrated to remove unnecessary planes
that block the virtual camera view. Near Clipping Distance is great for tight shots
when a virtual plane or object is blocking the virtual camera view.
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1.

If composing a shot and the virtual camera is being blocked or is clipping
through a surface or object, use Near Clipping Distance to “clip away” the
virtual surface/object to unblock the virtual camera view. While in play mode,
this can be adjusted in one of two ways:
a. In Unreal Engine:
i. Navigate to ARwall Camera Actor > Details > ARwall > Near
Clipping Distance.
ii. Adjust the value to see the blocking virtual plane
disappear/reappear.

T Details ® World Settings
%
4+ Add Component ~ o7 Blueprint/Add Script

zomponent) (Inherited)

ARwallCamera

|
oo R

b. In ARwall Options Menu:
i. Press Backslash on the keyboard to toggle on the ARFX Options
Menu and navigate to ARFX > ARFX Camera Options > Near
Clip Distance.
ii. Adjust the value to see the blocking virtual plane
disappear/reappear.
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Tracking

Movement Speed

Yaw / Pitch Speed
Post Process

Screen Dimensions (cm) [WxH]

Near Clip Distance
Controls

Bookmark Transition Speed

Graphics

Audio

Sate Hero Serial

Cancel Calibration Serial

Tracking Delay
Threshold Sample Size

Velocity Threshold
Quit to Desktop

Disabled

LHR-DOD5F19C
LHR-DODSF19C
0 frames

4

Distance at which the camera will clip objects too close to the screen/wall

NOTE: A higher Near Clipping Distance value will make anything near that distance
to the virtual camera disappear. Readjust to a lower value if too many

objects/surfaces disappear.

Section 7: ARFX Options Menu

This section describes our menu system within play mode. No longer are the days of
having to exit play mode, makes changes, save those changes and re-entering play

mode to see those changes in action.

Section 7.1: ARFX Options Menu Sub Menus for use in Real-Time

To access our menu system simply press the ESC or Backslash (\) key.

1. ARFXhas integrated all the necessary features to allow you to quickly access
all your favorite tools in one location, all accessible while still in play mode.
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Post Process

Controls
Graphics
Audio

Resume

Quit to Desktop

Post Process

Controls
Graphics
Audio

Resume

Quit to Desktop

a. ARFX:
i. ARFX Camera Options: Allow you to have further control over
the ARwall Camera Actor within the scene

1.
2.

Tracking Enabled
Movement Speed

Yaw / Pitch Speed

Screen Dimensions (cm) [WxH]

Near Clip Distance

Bookmark Transition Speed

Hero Serial

Calibration Serial

Tracking Delay 0 frames
Threshold Sample Size 4

Velocity Threshold

Tracking Enabled
Movement Speed

Yaw / Pitch Speed

Screen Dimensions (cm) [WxH]

Near Clip Distance

Bookmark Transition Speed

Hero Serial

Calibration Serial

Tracking Delay 0 frames
Threshold Sample Size 4

Velocity Threshold

Angular Velocity Threshold

Tracking: Toggles tracking on/off.

Movement Speed: Input speed of the virtual camera as
it moves around.

Yaw/Pitch Speed: Movement speed of virtual camera
pan and tilt.

Screen Dimensions (cm) [WxH]: Physical Dimension of
the screen in centimeters.

Near Clip Distance: Distance at which the virtual
camera will clip objects too close to the screen/wall.
Bookmark Transition Speed: Speed at which the
camera will transition between bookmarks.
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Controls
Graphics

Audio

Resume

Quit to Desktop

ii. SteamVR Setup: Ability to fix Tracker Serial numbers and fine

tune SteamVR settings

1.

2.

Hero Serial: Serial number can be found via
USBDeview.

Calibration Serial: Serial Number can be found via
USBDeview.

Tracking Delay: Delays the tracking by this number of
frames.

Threshold Sample Size: Number of samples we take to
determine velocity and angular velocity.

Velocity Threshold: Threshold at which we start
tracking.

Angular Velocity Threshold: Threshold at which we
start tracking.

Go To Fullscreen Options

Temperature Type White Balance >

Temperature 6,500K

Tint

0.00000

Saturation

Contrast

Gamma

Gain
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Saturation
Contrast
Gamma
Gain

Shadows Max
Controls

Graphics

Audio

Saturation
Resume Contrast
Gamma

Gain

Quit to Desktop

Saturation

Contrast

Control
‘i Gamma

Graphics 3
g Gain

Audio

Minimum Highlights

Resume

Blue Correction
Expand Gamut

Tone Curve Amount
Quit to Desktop

b. Post Process: This section allows you to take further control over all
your post process needs including:
i. Go To Fullscreen Options: Clicking this allows you to hide the
ARFX options Menu overlay to see the scene fully while making
changes in real-time.
ii. Temperature:
1. Temperature Type: Selects the type of temperature

calculation.
2. Temperature: Temperature in Kelvin
3. Tint
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ARFX

Post Process

Graphics
Audio

Resume

Quit to Desktop

iil.

v.

Vi.

vii.

Global:

1.
2.
3.
4,

Saturation
Contrast
Gamma
Gain

Shadows:

1.
2.
3.
4,

5

Saturation
Contrast
Gamma

Gain
Shadows Max

Midtones:

1.
2.
3.
4,

Saturation
Contrast
Gamma
Gain

Highlights:

Saturation

Contrast

Gamma

Gain

Minimum Highlights

Blue Correction
Expand Gamut
Tone Curve Amount

Customize Controls  Reset

Show Default Gamepad Controls
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ARFX

Post Process

Graphics
Audio

Resume

Quit to Desktop

ARFX

Post Process

Graphics

Audio

Resume

Quit to Desktop

Move Vertically Down

Rotate 90° Leh—\ 5 Toggle Debug Info
]

Stick: Move Camera

Press: Toggle Snap Mode
Normal (Tap): Toggle Rotation Method
Normal (Hold): Reset Pitch/Roll

Snap Mode (Tap): Snap Vertically Up

Snap Mode (Hold): Snap Forwarm\

Normal: Create Bookmark
Focus Enabled: Focal Distance (-)
Snap Mode: Snap Horizontally Left

Normal (Tap): Toggle Move Method
Normal (Hold): Toggle Focal Distance Input

Open Menu

Snap Mode (Tap): Snap Vertically Down Norrhal: Next Bookmark
Snap Mode (Hold): Snap Back Focus Enabled: Focal Distance (+)
Snap Mode: Snap Horizontally Right

Customize Controls

Move Vertically Up

Rotate 90° Right
n
w

Toggle Calibrate Menu
/ (Y —————Toggle Focal Distance Input

X

B ————calibrate Screen

A -Toggle Focus Method

Stick: Rotate Camera
Press: Toggle Focal Method

Show Default Keyboard Controls

Toggle Calibration Menu
Calibrate Screen

Toggle Debug Information
Toggle Focus Method

Toggle Focus Debug Plane

Move Camera Forwa
Move Camera Back
Move Camera Left
Move Camera Right

Move Camera Up

Customize Controls

Gamepad X

Gamepad B

Select

Gamepad A

Gamepad Y.

Reset
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Customize Controls
Move Camera Right

Move Camera Up
ARFX Move Camera Down
Post Process Rotate Camera Left

Rotate Camera Right

Turn Camera 90° Left Left Bumper
Graphics Turn Camera 90° Right Right Bumper
Audio Rotate Camera Up

Rotate Camera Down
Resume Toggle Rotation Method None
Toggle Snap Controls Left Stick

Reset Camera Pitch and Roll None

Quit to Desktop

Customize Controls

Dpad Up (Tgl/Reset Rotation, Snap Up/Forward) Pad Up None
ARFX Dpad Down (Tgl Move Method/Focus Input, Snap Down/Back) Pad Down None
Post Process Dpad Left (Create Bookmark, Snap/Focus Left) Pad Left None
Dpad Right (Next Bookmark, Snap/Focus Right) Pad Right None
Key Up (Pitch/Focus/Snap Up) Up None

Graphics Key Down (Pitch/Focus/Snap Down) Down. None
Audio

Key Left (Yaw/Snap Left) Left None
Key Right (Yaw/Snap Right) Right None

Resume

Create Bookmark Backspace

Next Bookmark Equals
Quit to Desktop
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Customize Controls Reset

Create Bookmark Backspace
ARFX

Next Bookmark Equals
Post Process

Previous Bookmark Hyphen

Graphics

Audio Calibrate Rig

Calibrate Scene

Resume

Move Rig Forward
Move Rig Back

Quit to Desktop

Customize Controls Reset

ARFX

Post Process Move Rig Forward Num 8
Move Rig Back Num 2
Move Rig Left Num 4
Graphics Move Rig Right Num 6
Audio Move Rig Up Num 9

Move Rig Down Num 7

Resume

Next Bookmark Equals
Previous Bookmark Hyphen

Quit to Desktop

c. Controls: (Hotkeys Customization for both Keyboard & Controller)
i. Default loads a keyboard with all the controls.
ii. Show Default Gamepad Controls: Change the Ul to view the
Xbox controller settings.
iii. Customize Controls: Every single hotkey on both keyboard
and controller can be customized.
1. If any hotkeys are changed, selecting Controls should
load the list of Controls instead of the default image of
the keyboard /Xbox Controller
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iv. Reset: Resets all hotkeys to the default inputs.
v. Toggle Rotation Method (V on keyboard, D-PAD Up Arrow
on Xbox controller)
1. Rotate at Screen:
a. Rotates at virtual camera location
b. Can rotate left and right
c. Can pitch up and down
2. Rotate at Camera (Yaw Only)
a. Rotates where the Hero Puck is in physical space
b. Can rotate left and right
c. Cannot pitch up and down
vi. Toggle Snap Mode (T on keyboard, Left Stick button on Xbox
Controller)
1. Forces virtual camera to snap towards the nearest
surface in a direction on the virtual environment

Default
Quality Preset Custom

ARFX

Post Process
Resolution Scale 100% Apply
(WS

Display Mode Windowed Fullscreen » Apply

Resolution 1024x768 > Apply

Gamma 2.2

V-Sync Enabled >

Hesue Max FPS < 5

Anientranic Filterina

Quit to Desktop

62



Default

ARFX

Post Process

Controls

Resume

Quit to Desktop

Anisotropic Filtering

Textures

Post-Processing Epic

Anti-Aliasing High
Shadows Very High
Effects Epic
Detail Mode High
Foliage High

View Distance Very High

<
<
<
<
<
<
<
S

S v Sl sl ine | Il sl s

Motion Blur [eli

Planar Reflections

d. Graphics: This section gives you greater control of the overall quality

settings of the scene including:
i. Global Settings:
1. Quality Preset: Adjust the quality of all graphics and
textures settings.
ii. Display Settings:
1. Resolution Scale: Adjust the sharpness of the game
graphics. When it’s too low, the items could show in a
blurry image.
Display Mode: Select the display mode.
Resolution: Select the display resolution.
Gamma: Adjust the gamma Calibration.
V-Sync: Vertical synchronisation prevent screen tearing.
6. Max FPS: Select the max FPS.
iii. Texture Settings:
1. Anisotropic Filtering: Reducing blur and preserving
detail at extreme viewing angles.
2. Textures: Adjust the quality of the textures.
iv. Graphic Settings:
1. Post-Processing: Adjust the quality of post processing
effects.
2. Anti-Aliasing: Adjust quality of AA, smooths the object’s
graphics. It is recommended to turn this on.
3. Shadows: Adjust the quality of the shadows for
character and objects.

v Wi
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4. Effects: Adjust the quality of various effects like
reflections and the material fidelity. (Can take a
moment)

5. Detail Mode: Adjust the minimum detail level for an
actor to render.

6. Foliage: Adjust the quality of Foliage.

7. View Distance: Adjust the visible distance, objects will
be hidden based on their distance to the player.

8. Motion Blur: Adjust the blur quality on fast moving
objects.

9. Planar Reflections: Sets any and all planar reflections
in the scene to render at a % of the screen’s resolution.
Recommended at 50% or lower.

Master

ARFX

Music
Post Process

Effects

Voice
Controls

Graphics

Resume

Quit to Desktop

e. Audio: Provides you with greater control of your audio settings if
applicable.
i. Audio Settings:
1. Master: Adjust all Volume.
2. Music: Adjust the Music Volume.
3. Effects: Adjust the Effects Volume.
4. Voice: Adjust the Voice Volume.
f. Resume
i. If you have made changes to any of the above settings it will
ask you if you want to save before resuming.
g. Cancel
i. This will cancel any changes made to the above settings and
resume play.
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h. Quit to Desktop
i. This will exit the application.

Section 8: Troubleshooting
This section describes how to correct common issues that may occur.

Section 8.1: Adjust Vive Trackers

This section describes how to correct the Vive Trackers if they are not working,

USBDeview

If the Vive Trackers are not tracking or if the ARFX Launcher (if available) is not
able to automatically pull in the tracker serial numbers, double check the serial
numbers. Use the following procedure:

4. Connect the USB-A to Micro USB (for Tracker 2.0) or USB-A to USB-C (for
Tracker 3.0) cable from the computer to the Vive Tracker.
5. Open the USBDeview on your desktop.

=

&
USED@viiw

6. Inthe USBDeview, under the Serial Number column, look for something that
starts with LHR. It will be listed with a serial number. If it displays as green,
this means it is active and connected to the machine.

a. To differentiate between the two trackers, connect only one tracker at
a time and see what shows up in USBDeview.

ﬁUSEDeview
File Edit View Options Help

X@looo HRmE A

Device Name Description Device Type Connected Safe To Unpl... Disabled USB Hub Drive Letter Serial Number

@ LHR USB Composite Device Unknown Yes Yes No No LHR-DF83EEB3

BEST PRACTICE: It is recommended to label your trackers with their unique Serial
Number for ease of identification on set. It is also recommended to label which wireless
USB Dongle belongs to which tracker by identifying them as A, B, etc. for ease of future
identification and troubleshooting.

A two-Vive Tracker system is generally recommended, with a Calibration Vive
Tracker and a Hero Vive Tracker, but if only one tracker is available, please be sure
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to use the same Serial Number of your one Vive Tracker for both Calibration Tracker
and Hero Tracker fields.

SteamVR

If the Vive Trackers serial numbers are input correctly but are still not tracking, use
SteamVR to help troubleshoot.

1. Quit out of Unreal Engine if project file is still open.

2. Navigate to the SteamVR window or launch it if it is not on.

3. If SteamVR asks for a head-mounted display (HMD), launch the ARFX
Launcher (if available) and click on Patch SteamVR button and relaunch
SteamVR. Or refer to Section 2.5 SteamVR Software Set Up to do this step
manually. This should remove the requirement for the HMD and show you
any connected Vive Trackers and Base Stations.

4. If there are any missing Vive Trackers and/or Base Stations:

a. Double check USB cables and USB extension cables for Vive Trackers
are fully connected into the Trackers and the computer.

i. Ifthere is a lot of wireless/mobile interference in a space, it’s
best to keep Vive Trackers wired instead of relying purely on
the wireless dongle.

ii. Asking nearby cast/crew members to turn off their mobile
devices may also help improve tracking in general.

b. Make sure to position the trackers and base stations so they can see
each other. Give it a few moments as it usually takes a few seconds
before SteamVR will recognize a previously unconnected device.

c. Double check that the trackers have a green (active) or amber (active
and charging) light showing on their LED light.

i. Ifatracker LED light is showing blue or white instead, be sure
to press the Vive Tracker button. This should turn it green or
amber.

d. If using more than two Base Stations, make sure that all base stations
are on their own unique channels.

5. Ifnone of the above work, restart the computer and start up SteamVR and the
Unreal Engine Scene powered with ARFX Pro Plugin again.

SteamVR may stop tracking and go to sleep if the trackers have been unmoving or
out of view of the Base Stations for too long. If this occurs, do the following:

1. Close the UE4/5 project.
2. Close or restart SteamVR, and then reopen it to repeat the pairing process
with the tracker.

If the tracker has been lost entirely, will not repair, or the computer crashes, then
restart the computer and set up the SteamVR and Unreal Engine again.
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Section 8.2: Tracking and Jittering Issues

If you are having jitters with the tracking,
1. Make sure there isn’t any IR being reflected towards the puck

a. This can cause the puck to jitter and lose tracking, but the tracking
will come back.

b. Ifyou are losing tracking, make sure the puck isn’t being blocked, and
it is being seen by the Base Stations.

c. Itis possible someone may have accidently bumped one of the Base
Stations while setting up. In this case you will just need to
recalibrate.

2. Ifthese solutions haven’t worked out, you can hardwire the puck using a USB-
A to Micro-USB or USB-A to USB-C cable. This will stop the jitteriness.

BEST PRACTICE: If tracking is jerky for a slow-moving hero camera shot:
o Unreal Engine 4:
o Lower the Positional Threshold and Angular Threshold values down
by 0.01 or 0.001 increments at a time until the tracking is smooth.
o Ifthe hero tracker is sitting still but there is perceived jitter on the
ARFX background, increase the Positional Threshold and Angular
Threshold values up by 0.01 or 0.001 increments until the jitter no
longer shows.
o Unreal Engine 5:
o Lower the Positional Power Threshold and Angular Power Threshold
values down by 1 increment at a time until the tracking is smooth.
o Ifthe hero tracker is sitting still but there is perceived jitter on the
ARFX background, increase the Positional Power Threshold and
Angular Power Threshold values up 1 increment until the jitter no
longer shows.

Section 8.3: Recommended Wires

All wires used with ARwall should be the most up-to-date versions for best
performance:

e HDMI should be minimum of 2.0.

e DisplayPort should be minimum 1.4.

e If converters are used, be sure to match the minimum versions listed above.

e USB-A Extension Cables should be a minimum of 2.0 or 3.0. If this cable needs
to extend longer than 50 feet, fiber optic USB extension cables are
recommended.

o Itisrecommended to plug trackers directly into the USB slots on the
motherboard. Avoid plugging into USB hubs if tracking issues occur
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Section 8.4: Unreal Engine System Issues
If the Unreal Engine crashes, do the following:

1. Click Close without resending.

2. Re-open the UE4/5 project, play scene, and recalibrate the scene.
The SteamVR engine is still running and tracking in the event of an Unreal
Engine crash. Once you re-open the UE4/5 project, the SteamVR will continue
tracking.

3. Test the tracker for confirmation that it is working or verify by looking at the
SteamVR window.

Section 8.5: Project File Launch / Login Issues
1. If the Unreal project keeps closing or not opening the login window, a few
different things may have happened:
a. Ifthelogin window does not appear make sure to download .NET6
Runtime.

i. This is required for the login window to communicate with our
software. You can download your appropriate .NET6 Runtime
here.

b. Ifyou entered an incorrect Activation Code with your login and
password, follow these steps for the Plugin.

i. Open your project folder

ii. Locate the ‘Saved’ folder -> ‘Config’ folder -> ‘Windows’ folder -
> delete the ‘ARwall.ini’ file

Window: - o0 x
@ New &% O B =B W M Sort = view
€ T <« UEA Project » Saved » Config » Windows v C Search Windows
Name Date modified Type Size
~ [l ThisPC
L] ARwall Configuration sett... 1KB
> @ Desktop
£] CameraCalibrationCore Configuration seit... KB
> [ Documents
L] Compat Configuration seft... KB
> & Downloads
£] Composure Configuration sett... 1KB
> @ Music
L] ConcertsyncCore Configuration sett... KB
> N Pictures
L] DeviceProfiles Configuration sett... 1KE
> [ Videos
L] Editor Configuration sett... KB
> e Local Disk (C)
L] EditorPerProjectUserSettings Configuration sett... 91 KB
> = ApplicationsSsD (D:)
L] EditorScriptingUtilities Configuration sett... 1KE
> = HHD (B
= L] Engine Configuration sett... 4KB
> =5 ARwall HDOZ (F) £ Game Configuration seft... 1KB
> W seagete Backup Plus Dri L] GameUserSettings Configuration sett... 1KB
> == T3VideoSSD (H) 1] Hardware Configuration seft... KB
v = ARwall HDOZ (F) £ Input Configuration sett... 18KB
AmenBiAmenLoge L] Lightmass ¥, y Configuration seit... 1KB
33items 1 item selected 76 bytes EQ

iii. Then launch the project and a prompt to ask you to enter your
Activation Code.
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Glossary

A

ARwallCameraActor: An Unreal Camera in the form of an Actor in the Unreal
Engine, which you activate in the Unreal Scene to view the ARwall. This is a
proprietary plugin developed by ARwall.

C
Camera Offset: Allows you to change the settings inside the Unreal Engine to match
the physical set.

L
Base Station: Rectangular boxes with motion-sensing capabilities.

S

SteamVR: The SteamVR Desktop Theater Mode allows you to play your

entire Steam game library in virtual reality on a virtual big screen TV. First put your
headset on and access SteamVR, and then use the menu to launch a non-VR game in
your library.

u

Unreal Engine: a complete suite of development tools designed for real-time
technology that includes everything from enterprise applications and cinematic
experiences to high-quality games across PCs, consoles, mobiles, VR and AR.

4
Vive Dongle: Reads the Vive Tracker.

Vive Tracker: Puck-shaped device used to track motion within the range of the
motion-sensing Base Station.
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Default Hotkey Layouts for Keyboard and Xbox Controller
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